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ศูนย์ป้องกันวิกฤติน ้ำ กรมทรัพยำกรน ้ำ

Mekong River Commission Flash Flood 
Guidance System: MRCFFGS
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สุประภำพ พัฒน์สิงหเสนีย์
วิศวกรโยธำช้ำนำญกำรพิเศษ

ศูนย์ป้องกันวิกฤติน ้ำ กรมทรัพยำกรน ้ำ
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รำยละเอียดกำรน้ำเสนอ:

หัวข้อที่ 1: แนวคิดกำรพัฒนำระบบ MRCFFGS
หัวข้อที่ 2: MRCFFGS CONSOLE 
หัวข้อที่ 3: กำรประยุกต์ใช้งำนระบบ MRCFFGS
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หัวข้อที่ 1: แนวคิดกำรพัฒนำระบบ MRCFFGS
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(1) ควำมเป็นมำของระบบ
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(1) ควำมเป็นมำของระบบ
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(1) ควำมเป็นมำของระบบ

กำรเกิดสภำวะน ้ำท่วมในช่วงเวลำสั นโดยมีสำเหตุจำกปริมำณน ้ำท่ำที่มำก

กำรเกิดสภำวะน ้ำท่วมอย่ำงฉับพลัน โดยมีระยะเวลำในกำรเตือนภัยที่สั น 
ซึ่งเกิดจำกควำมเข้มของฝนที่ตกหนักในพื นที่ขนำดเล็ก
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(1) ควำมเป็นมำของระบบ
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(1) ควำมเป็นมำของระบบ



03/01/61

5

Page 9

(1) ควำมเป็นมำของระบบ
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(1) ควำมเป็นมำของระบบ

น ้ำท่วมในพื นที่รำบลุ่มล้ำน ้ำ น ้ำท่วมฉับพลัน
ระยะเวลำในกำรท่วมขังนำน ระยะเวลำในกำรท่วมขังน้อยกว่ำ 12 ชั่วโมง

ข้อมูลปริมำณน ้ำท่ำสำมำรถประมำณอย่ำงครำวๆได้ ข้อมูลปริมำณน ้ำท่ำต้องประมำณอย่ำงละเอียด

ข้อมูลเชิงพื นท่ีมีควำมส้ำคัญ ข้อมูลเชิงพื นท่ีมีควำมส้ำคัญมำก

คำดกำรณ์ด้ำนอุทกวิทยำ และชลศำสตร์ คำดกำรณ์ด้ำนอุตุนิยทวิทยำ อุทกวิทยำ 

และชลศำสตร์

ระยะเวลำในกำรพิจำรณำพอสมควร ระยะเวลำในกำรพิจำรณำน้อย

ควำมแตกต่ำงระหว่ำงน ้ำท่วมฉับพลนักับสภำวะน ้ำทว่มในพื นที่รำบลุม่ล้ำน ้ำ
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(1) ควำมเป็นมำของระบบ

Page 12

(1) ควำมเป็นมำของระบบ

ค่ำที่ควำมสำมำรถในกำรรองรับปริมำณฝนของพื นที่นั นๆ ก่อนที่จะเกิดสภำวะน ้ำล้นตลิ่งที่จุดออกของปลำยพื นท่ีนั นๆ
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(2) กำรแบ่งพื นที่ลุ่มน ้ำ
▪ ข้อมูลเส้นชั นควำมสูงจำก SRTM 

90m Digital Elevation 
Database

▪ แบ่งพื นที่ลุ่มน ้ำของประเทศไทย 
สปป.ลำว เวียดนำม และกัมพูชำ 
ออกเป็นพื นที่รับน ้ำเล็กๆ (GRASS 
GIS)

▪ พื นที่ลุ่มน ้ำขนำดเล็กที่แบ่งได้ มี
ขนำดพื นที่รับน ้ำประมำณ 150-
200 ตร.กม. โดยมีค่ำเฉลี่ยอยู่ที่ 
182 ตร.กม.

▪ ระบบ MRCFFGS มีพื นที่ รั บน ้ ำ 
7,618 พื นที่รับน ้ำ0
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(3) Satellite Precipitation Estimation

ข้อมูลปริมำณฝนที่ใช้ในระบบ MRCFFGS นั นประกอบด้วย Global 
Hydro Estimator (GHE) และ Microwave adjusted Global Hydro 
Estimator (MWGHE) จำก NOAA's Geostationary Operational 
Environmental Satellites (GOES)

▪ GHE เป็นกำรตรวจวัดอุณหภูมิแสงสว่ำงของเมฆด้ำนบนด้วยคลื่น
อินฟรำเรด (IR based 10.7 µm.) และมีกำรตรวจวัดทุกๆ 30 นำที

▪MWGHE เป็นกำรตรวจวัดกำรกระจำยตัวของเม็ดฝนด้วยคลื่น
ไมโครเวฟ (Microwave) และมีกำรตรวจวัดทุกๆ 18-26 ชั่วโมง



03/01/61

8

Page 15

(3) Satellite Precipitation Estimation

MWGHE GHE
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(4) Climatological Precipitation Bias Adjustment

▪ Satellite Precipitation Estimation
ไม่ ไ ด้ เ ป็ นกำรตรวจวั ดปริ มำณฝน
โดยตรง  ดั งนั น กำรปรั บแก้ ข้ อมู ล
ดังกล่ำวกับข้อมูลตรวจวัดจึงมีควำม
จ้ำเป็น

▪ ผลลัพธ์ที่ได้จำกกำรปรับแก้ค่ำปริมำณ
ฝนจำก GHE และ MWGHE คือ ค่ำ
ปริมำณฝนเฉลี่ยเชิงพื นที่ (Mean Area 
Precipitation, MAP)

▪ กำรปรับแก้ค่ำปริมำณฝน อำศัยข้อมูล
ของสถำนีวัดน ้ำฝนกรมอุตุนิยมวิทยำ 
ระหว่ำงเดือนพฤษภำคม 2555 ถึง 
ตุลำคม 2560
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(4) Climatological Precipitation Bias Adjustment

MWGHE GHE MAP
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(5) Soil Moisture Model
▪ Sacramento Soil Moisture 

Accounting Model (SAC-
SMA)  ถูกประยุกต์ ใช้ งานใน
ระบบของ MRCFFGS 

▪ เพื่อการประเมินศักยภาพของ
ผิวดินที่สามารถรองรับและเก็บ
กักความชื้น โดยมีการพิจารณา
ระบบผิวดินและระบบใต้ดิน ซึ่ง
พิจารณาถึงการไหลซึมลงสู่ชั้น
ใต้ดิน ปริมาณน้้าท่าที่ไหลลงสู่
ทางน้้า และการคายระเหย
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หัวข้อที่ 2: MRCFFGS CONSOLE 
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(1) MRCFFGS CONSOLE
https://184.185.140.80/MRCFFG_CONSOLE

Username :   trainee
Password  :   HRC2017.train
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(2) MRCFFGS CONSOLE (Observation Precipitation)

Observation Precipitation
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(2) MRCFFGS CONSOLE (Observation Precipitation)

MWGHE (Microwave-adjusted Global HydroEstimator Satellite-
based Precipitation Estimates)

1) ข้อมูลมีกำรปรับปรุงทุกๆชั่วโมง
2) ข้อมูล MWGHE มีกำรน้ำเสนอในรูปแบบของปริมำณฝนสะสมจำก NOAA-NESDIS 

Global Hydro Estimator และมีกำรปรับแก้จำก NOAA-CPC CMORPH 
Microwave-based satellite rainfall ในรอบ 1, 3, 6, และ 24 ชั่วโมงที่ผ่ำนมำ

3) ข้อมูล MWGHE ในระบบ MRCFFGS เป็นข้อมูลที่ยังไม่ได้ปรับแก้ (Bias 
correction)

▪ MWGHE 01-hr หมำยถึง ปริมำณฝนคำดกำรณ์สะสม จำกระบบ Microwave adjusted 
Global HydroEstimator ในช่วง 1 ชั่วโมงที่ผ่ำนมำ (mm/1hr)

▪ MWGHE 03-hr หมำยถึง ปริมำณฝนคำดกำรณ์สะสม จำกระบบ Microwave adjusted 
Global HydroEstimator ในช่วง 3 ชั่วโมงที่ผ่ำนมำ (mm/3hr)

▪ MWGHE 06-hr หมำยถึง ปริมำณฝนคำดกำรณ์สะสม จำกระบบ Microwave adjusted 
Global HydroEstimator ในช่วง 6 ชั่วโมงที่ผ่ำนมำ (mm/6hr)

▪ MWGHE 24-hr หมำยถึง ปริมำณฝนคำดกำรณ์สะสม จำกระบบ Microwave adjusted 
Global HydroEstimator ในช่วง 24 ชั่วโมงที่ผ่ำนมำ (mm/24hr)
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GHE (Global HydroEstimator Satellite-based Precipitation 
Estimate)

1) ข้อมูลมีกำรปรับปรุงทุกๆชั่วโมง
2) ข้อมูล GHE ในระบบ MRCFFGS จะมีกำรน้ำเสนอในรูปแบบของปริมำณ

ฝนสะสมจำก NOAA-NESDIS Global Hydro Estimator ในรอบ 1, 3, 
6, และ 24 ชั่วโมงที่ผ่ำนมำ ตำมล้ำดับ

3) ข้อมูล GHE ในระบบ MRCFFGS เป็นข้อมูลที่ยังไม่ได้ปรับแก้ (Bias 
correction)
▪ GHE 01-hr หมำยถึง ปริมำณฝนคำดกำรณ์สะสม จำกระบบ Global HydroEstimator

ในช่วง 1 ชั่วโมงที่ผ่ำนมำ (mm/1hr)
▪ GHE 03-hr หมำยถึง ปริมำณฝนคำดกำรณ์สะสม จำกระบบ Global HydroEstimator

ในช่วง 3 ชั่วโมงที่ผ่ำนมำ (mm/3hr)
▪ GHE 06-hr หมำยถึง ปริมำณฝนคำดกำรณ์สะสม จำกระบบ Global HydroEstimator

ในช่วง 6 ชั่วโมงที่ผ่ำนมำ (mm/6hr)
▪ GHE 24-hr หมำยถึง ปริมำณฝนคำดกำรณ์สะสม จำกระบบ Global HydroEstimator

ในช่วง 24 ชั่วโมงที่ผ่ำนมำ (mm/24hr)

(2) MRCFFGS CONSOLE (Observation Precipitation)

Page 24

(2) MRCFFGS CONSOLE (Observation Precipitation)

Gauge MAP (Gauge Mean Areal Precipitation)

1) ข้อมูลมีกำรปรับปรุง ณ เวลำ 00, 06, 12 และ 18 UTC
2) ข้อมูล Gauge MAP ในแต่ละพื นที่จะอำศยักำร Interpolate 

จำกสถำนีวัดน ้ำฝนที่มีกำรตรวจวัดจริง ที่ 06-hr และ 24-hr
ตำมล้ำดับ

▪ GMAP 06-hr หมำยถึง ปริมำณ GMAP ในช่วงเวลำ 6 
ชั่วโมงที่ผ่ำนมำ

▪ GMAP 24-hr หมำยถึง ปริมำณ GMAP ในช่วงเวลำ 24 
ชั่วโมงที่ผ่ำนมำ)
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(2) MRCFFGS CONSOLE (Observation Precipitation)

MAP (Merged Areal Precipitation)

1) ข้อมูลมีกำรปรับปรุงทุกๆชั่วโมง
2) ข้อมูล MAP ในระบบ MRCFFGS จะมีกำรน้ำเสนอในรูปแบบของปริมำณ

ฝนสะสมในรอบ 1, 3, 6, และ 24 ชั่วโมงที่ผ่ำนมำ
3) ข้อมูล MAP นั นประมวลผลจำกชุดข้อมูลที่ดีที่สุดภำยหลังจำกกำรจัดท้ำ 

Bias adjustment ของ MWGHE, GHE หรือ GMAP ตำมล้ำดับ
4) ข้อมูล MAP จะถูกน้ำไปใช้เป็นข้อมูลน้ำเข้ำในแบบจ้ำลอง Sacramento 

Soil Moisture Accounting Model

▪ MAP 01-hr หมำยถึง ปริมำณฝนสะสมในช่วง 1 ชั่วโมงที่ผ่ำนมำ (mm/1hr)
▪ MAP 03-hr หมำยถึง ปริมำณฝนสะสมในช่วง 3 ชั่วโมงที่ผ่ำนมำ (mm/3hr)
▪ MAP 06-hr หมำยถึง ปริมำณฝนสะสมในช่วง 6 ชั่วโมงที่ผ่ำนมำ (mm/6hr)
▪ MAP 24-hr หมำยถึง ปริมำณฝนสะสมในช่วง 24 ชั่วโมงที่ผ่ำนมำ (mm/24hr)

Page 26

Hydrologic State

(3) MRCFFGS CONSOLE (Hydrologic State)
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(3) MRCFFGS CONSOLE (Hydrologic State)
ASM (Average Soil Moisture)

1) ข้อมูลมีกำรปรับปรุง ณ เวลำ 00, 06, 12 และ 18 UTC
2) ข้อมูล ASM แสดงอัตรำส่วนควำมชุ่มชื นของดินที่ชั นควำมลึกประมำณ 10-

20 ซม. (0-1) โดย 0 หมำยถึง ดินที่แห้งสนิท และ 1 หมำยถึง ดินที่มีควำม
ชุ่มน ้ำ 100%

3) ข้อมูล ASM ได้มำจำกแบบจ้ำลอง Sacramento Soil Moisture 
Accounting Model

Page 28

(3) MRCFFGS CONSOLE (Hydrologic State)
FFG (Flash Flood Guidance)

1) ข้อมูลมีกำรปรับปรุง ณ เวลำ 00, 06, 12 และ 18 UTC
2) ข้อมูล FFG หมำยถึง ค่ำที่ควำมสำมำรถในกำรรองรับปริมำณฝนของพื นที่

นั นๆ ก่อนที่จะเกิดสภำวะน ้ำล้นตลิ่งที่จุดออกของปลำยพื นที่นั นๆ ดังนั นเมื่อ
ปริมำณฝนมีค่ำสูงกว่ำ FFG จะเป็นข้อมูลสนับสนุนกำรตัดสินใจว่ำจะเกิด
สภำวะน ้ำล้นตลิ่งที่จุดออกของพื นที่นั น

▪ FFG 01-hr หมำยถึง ปริมำณฝนที่จะส่งผลให้เกิดสภำวะน ้ำล้นตลิ่งที่ปลำยลุ่มน ้ำ
ในอีก 1 ชั่วโมงข้ำงหน้ำ (mm/1hr)

▪ FFG 03-hr หมำยถึง ปริมำณฝนที่จะส่งผลให้เกิดสภำวะน ้ำล้นตลิ่งที่ปลำยลุ่มน ้ำ
ในอีก 3 ชั่วโมงข้ำงหน้ำ (mm/3hr)

▪ FFG 06-hr หมำยถึง ปริมำณฝนที่จะส่งผลให้เกิดสภำวะน ้ำล้นตลิ่งที่ปลำยลุ่มน ้ำ
ในอีก 1 ชั่วโมงข้ำงหน้ำ (mm/6hr)



03/01/61

15

Page 29

Flash Flood Indicators

(4) MRCFFGS CONSOLE (Flash Flood Indicators)

Page 30

(4) MRCFFGS CONSOLE (Flash Flood Indicators)
IFFT (Imminent Flash Flood Threat)

1) ข้อมูลมีกำรปรับปรุง ณ เวลำ 00, 06, 12 และ 18 UTC
2) ข้อมูล IFFT หมำยถึง ค่ำผลต่ำงของ MAP ของช่วงเวลำที่สนใจ กับ ค่ำ FFG ของ

ช่วงเวลำที่ผ่ำนมำ
3) ข้อมูล IFFT ในรูปแบบแผนที่นั นจะแสดงด้วยสีต่ำงๆ โดย สีเหลือง หมำยถึง พื นที่

ที่ควรให้ควำมส้ำคัญและติดตำมสถำนกำรณ์ และ สีแดง หมำยถึง พื นที่ที่เสี่ยงต่อ
กำรเกิดน ้ำหลำกดินถล่ม

4) ข้อมูล IFFT เกิดจำกกำรประเมินโดยอำศัยข้อมูลในอดีต ดังนั นผู้ที่จะติดตำม
สถำนกำรณ์ควรจะให้ควำมส้ำคัญกับข้อมูลในปัจจุบัน เปรียบเทียบกับค่ำ IFFT 
ก่อนที่จะมีกำรเตือนภัย

▪ 01-hr IFFT 13UTC = 01-hr Merged MAP 13UTC – 01-hr FFG 12UTC (mm/1hr)
▪ 03-hr IFFT 15UTC = 03-hr Merged MAP 15UTC – 03-hr FFG 12UTC (mm/1hr)
▪ 06-hr IFFT 18UTC = 06-hr Merged MAP 18UTC – 06-hr FFG 12UTC (mm/1hr)
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(4) MRCFFGS CONSOLE (Flash Flood Indicators)
PFFT (Persistence Flash Flood Threat)

1) ข้อมูลมีกำรปรับปรุง ณ เวลำ 00, 06, 12 และ 18 UTC
2) ข้อมูล PFFT หมำยถึง ค่ำผลต่ำงของ MAP ของช่วงเวลำปัจจุบัน กับ 

ค่ำ FFG ของช่วงเวลำปัจจุบัน 
3) ข้อมูล PFFT ในรูปแบบแผนที่นั นจะแสดงด้วยสีต่ำงๆ โดย สีเหลือง 

หมำยถึง พื นที่ที่ควรให้ควำมส้ำคัญและติดตำมสถำนกำรณ์ และ สี
แดง หมำยถึง พื นที่ที่เสี่ยงต่อกำรเกิดน ้ำหลำกดินถล่ม

▪ 01-hr PFFT 12UTC = 01-hr Merged MAP 12UTC – 01-hr FFG 12UTC (mm/1hr) 
เพื่อสนใจสถำนกำรณ์ที่จะเกิดขึ น ณ ช่วงเวลำ 13UTC

▪ 03-hr PFFT 12UTC = 03-hr Merged MAP 12UTC – 03-hr FFG 12UTC (mm/1hr) 
เพื่อสนใจสถำนกำรณ์ที่จะเกิดขึ น ณ ช่วงเวลำ 15UTC

▪ 06-hr PFFT 12UTC = 06-hr Merged MAP 12UTC – 06-hr FFG 12UTC (mm/1hr) 
เพื่อสนใจสถำนกำรณ์ที่จะเกิดขึ น ณ ช่วงเวลำ 18UTC

Page 32

(5) MRCFFGS CONSOLE (Forecast Precipitation)
WRF Forecast (WRF Model Precipitation Forecast)

1) ข้อมูลมีกำรปรับปรุงทุกๆ ชั่วโมง
2) ข้อมูล WRF Forecast แสดงค่ำปริมำณฝน

คำดกำรณ์จำกระบบ MRCWRF Model ในช่วง 
1-hr, 3-hr, 6-hr, และ 24-hr

▪ 01-hr WRF Forecast = ปริมำณฝนคำดกำรณ์
สะสม 1 ชั่วโมง (mm/1hr)

▪ 03-hr WRF Forecast = ปริมำณฝนคำดกำรณ์
สะสม 3 ชั่วโมง (mm/3hr)

▪ 06-hr WRF Forecast = ปริมำณฝนคำดกำรณ์
สะสม 6 ชั่วโมง (mm/6hr)

▪ 24-hr WRF Forecast = ปริมำณฝนคำดกำรณ์
สะสม 24 ชั่วโมง (mm/24hr)
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(5) MRCFFGS CONSOLE (Forecast Precipitation)
FMAP (Forecast Mean Areal Precipitation)

1) ข้อมูลมีกำรปรับปรุงทุกๆ ชั่วโมง
2) ข้อมูล Forecast Mean Areal Precipitation 

แสดงค่ ำปริมำณฝนคำดกำรณ์จำกระบบ 
MRCWRF Model ในช่วง 1-hr, 3-hr, 6-hr, 
และ 24-hr

▪ 01-hr FMAP = ปริมำณฝนคำดกำรณ์สะสม 1 
ชั่วโมง (mm/1hr)

▪ 03-hr FMAP = ปริมำณฝนคำดกำรณ์สะสม 3 
ชั่วโมง (mm/3hr)

▪ 06-hr FMAP = ปริมำณฝนคำดกำรณ์สะสม 6 
ชั่วโมง (mm/6hr)

▪ 24-hr FMAP = ปริมำณฝนคำดกำรณ์สะสม 24 
ชั่วโมง (mm/24hr)

Page 34

(5) MRCFFGS CONSOLE (Forecast Precipitation)
FFFT (Forecast Flash Flood Threat)

1) ข้อมูลมีกำรปรับปรุงทุกๆ 6 ชั่วโมง ณ เวลำ 00, 06, 12 
และ 18 UTC

2) ข้อมูล FFFT หมำยถึง ค่ำผลต่ำงของ FMAP ของ
ช่วงเวลำอนำคต กับ ค่ำ FFG ของช่วงเวลำปัจจุบัน

3) ข้อมูล FFFT ในรูปแบบแผนที่นั นจะแสดงด้วยสีต่ำงๆ 
โดย สีเหลือง หมำยถึง พื นที่ที่ควรให้ควำมส้ำคัญและ
ติดตำมสถำนกำรณ์ และ สีแดง หมำยถึง พื นที่ที่เสี่ยงต่อ
กำรเกิดน ้ำหลำกดินถล่ม

▪ 01-hr FFFT 12UTC = 01-hr FMAP 12UTC – 01-hr 
FFG 12UTC (mm/1hr) เพื่อสนใจสถำนกำรณ์ที่จะ
เกิดขึ น ณ ช่วงเวลำ 13UTC

▪ 03-hr FFFT 12UTC = 03-hr FMAP 12UTC – 03-hr 
FFG 12UTC (mm/3hr) เพื่อสนใจสถำนกำรณ์ที่จะ
เกิดขึ น ณ ช่วงเวลำ 15UTC

▪ 06-hr FFFT 12UTC = 06-hr FMAP 12UTC – 06-hr 
FFG 12UTC (mm/3hr) เพื่อสนใจสถำนกำรณ์ที่จะ
เกิดขึ น ณ ช่วงเวลำ 18UTC
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(6) MRCFFGS CONSOLE (Flash Flood Risk)

FFR (Flash Flood Risk)

1) ข้อมูลมีกำรปรับปรุงทุกๆ 6 ชั่วโมง ณ เวลำ 00, 06, 12 และ 
18 UTC

2) ข้อมูล FFR แสดงถึงควำมเป็นไปได้ในกำรเกิด Flash Flood 
ในช่วงเวลำ 12-hr, 24-hr, และ 36-hr ข้ำงหน้ำ โดยอำศัย
ข้อมูลปริมำณฝนคำดกำรณ์จำก WRF Model 
Precipitation Forecast โดยควำมเป็นไปในกำรเกิดมีค่ำ
ระหว่ำง 0.01-0.6

หัวข้อที่ 3: กำรประยุกต์ใช้งำนระบบ MRCFFGS
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(1) กำรติดตำมสถำนกำรณ์

https://184.185.140.80/MRCFFG_CONSOLE

Username :   trainee
Password  :   HRC2017.train

Page 38

(1) กำรติดตำมสถำนกำรณ์

เลือกช่วงเวลำทีพ่ิจำรณำ

Download CSV 
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Page 39

(1) กำรติดตำมสถำนกำรณ์

Page 40

(2) QGIS
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Page 41

(2) QGIS

Page 42

(3) Add Layer

(1) Layer>Add Layer>Add Vector Layer…

(2) Browse>>mrcffg_basins_03_thailand_operational_3sec_20171018.shp

(3) Open
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Page 43

(3) Add Layer

Page 44

(4) Add Table

ขึ นหน้ำต่ำง: Create a Layer from Delimited Text File

(4) Add Table
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Page 45

(5) เลอืก CSV ไฟรท์ี ่Download มาจากระบบ MRCFFGS

(6) เลอืก CSV

(7) เลอืก No geometry

(8) OK

(4) Add Table

Page 46

(4) Add Table
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Page 47
(9) Merge: Shape file กับ CSV

(10) หน้ำต่ำง Layer Properties

(5) Joint Table

Page 48

(10) Add vector join

(11) หน้ำต่ำง Add vector join

(5) Joint Table



03/01/61

25

Page 49

(12) Setup ค่ำต่ำงๆของ Add vector join

(13) OK

(5) Joint Table

Page 50

(15) OK (14) Apply

(5) Joint Table
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Page 51

(16) Open Attribute Table

(17) หน้ำต่ำงของ Open Attribute Table

(5) Joint Table

Page 52

(18) Web>OpenLayers plugin>Google Maps>Google Physical

(5) Add Background Map
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Page 53

(5) Add Background Map

Page 54

จัดท้ำแผนที่:
- MAP24 (มม./24ชม.)
- ASTM 
- FFG06 (มม./6ชม.)
- IFFT06 (มม./6ชม.)
- FMAP124 (มม./24ชม.)

(6) จัดท้ำแผนที่ Mean Areal Precipitation
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Page 55

(19) Layer Properties>Style

(6) จัดท้ำแผนที่ Mean Areal Precipitation

Page 56

(20) Layer Properties>Style>ก้ำหนดค่ำต่ำงๆ

(21) OK

(6) จัดท้ำแผนที่ Mean Areal Precipitation
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Page 57

(6) จัดท้ำแผนที่ Mean Areal Precipitation

Page 58

(22) สร้ำง Layout ส้ำหรับแผนที่
Project>New Print Composer

(23) ตั งชื่อ New Print Composer>MAP24

(6) จัดท้ำแผนที่ Mean Areal Precipitation
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Page 59

(24) หน้ำต่ำง New Print Composer>MAP24

(25) Setup>Page size>Orientation>Portrait

(6) จัดท้ำแผนที่ Mean Areal Precipitation

Page 60

(26) Add new map

(27) หน้ำต่ำงที่ปรำกฏก่อนจะ
ปรับแต่ง

(28) Move item 
content

(6) จัดท้ำแผนที่ Mean Areal Precipitation
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Page 61

(29) Add image

(30) picture>Search directories>เลือกรูป

(6) จัดท้ำแผนที่ Mean Areal Precipitation

Page 62

(29) Add new scalebar (30) scalebar

(6) จัดท้ำแผนที่ Mean Areal Precipitation
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Page 63

(31) Add new legend

(32) New legend

(6) จัดท้ำแผนที่ Mean Areal Precipitation

Page 64

(33) Print รูป: 
Composer>Export as Image…

(34) Save composition as

(35) Image export options

(6) จัดท้ำแผนที่ Mean Areal Precipitation
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Thank You



สถานการณ์ฝนและพื้นที่เสี่ยงอุทกภัยจากอิทธิพลของพายุไคตั๊ก (KAI-TAK) 

วันที่ 25 ธันวาคม 2560 เวลา 07:00 น. 

 

พ้ืนที่ภาคใต้ของประเทศไทยสามารถรองรับปริมาณฝนได้ประมาณ 120-180  มม./6ชม. และพ้ืนที่
ดังกล่าวมีปริมาณความชื้นในดินที่ประมาณประมาณ 60-80% โดยค่าดังกล่าวแสดงถึงศักยภาพในการรองรับ
ปริมาณน้้าฝนที่จะตกลงในพื้นที ่

ปริมาณฝนคาดการณ์ล่วงหน้า 24 ชั่วโมง (วันที่ 26 ธันวาคม 2560 เวลา 7:00 น.) โดยระบบ MRCFFG 
คาดการณ์ว่าในอีก 24 ชั่วโมงข้างหน้า ภาคใต้ของประเทศไทยจะมีปริมาณฝนสะสมสูงสุดประมาณ 30 มม./
24ชม. และระบบของ สสนก. คาดการณ์ว่าจะมีปริมาณฝนสะสมสูงสุดประมาณ 70 มม./24ชม. ซึ่งมีค่าน้อย
กว่าความสามรถในการรับน้้าฝนของพ้ืนที่ประมาณ 50-90 มม./6ชม. ดังนั้นจึงสามารถสรุปได้ว่าในอีก 24 
ชั่วโมงข้างหน้าพื้นที่ภาคใต้ของประเทศไทยยังไม่เสี่ยงต่อพื้นที่น้้าท่วมฉับพลัน แต่อย่างไรก็ตามควรจะเฝ้า
ติดตามสถานการณ์เพื่อดูการเปลี่ยนแปลงทุกๆ 3-6 ชั่วโมง 

 

1) ลักษณะส้าคัญทางภูมิอากาศ 

พยากรณ์อากาศ 24 ชั่วโมงข้างหน้า ประเทศไทยตอนบนยังคงมีอากาศหนาวเย็นต่อเนื่องกับมีหมอก
บางพ้ืนที่ โดยอุณหภูมิจะเปลี่ยนแปลงเล็กน้อย ส้าหรับภาคใต้ตอนล่างมีฝนตกหนักบางพ้ืนที่ มรสุม
ตะวันออกเฉียงเหนือที่พัดปกคลุมอ่าวไทยและภาคใต้มีก้าลังอ่อนลง ท้าให้คลื่นลมบริเวณอ่าวไทยมีก้าลังอ่อน
ลง โดยมีคลื่นสูงประมาณ 2 เมตร 

2) ปริมาณฝน 

ผลการเปรียบเทียบปริมาณฝนสะสม 24 ชั่วโมง ของวันที่ 24 (เวลา 07:00 น.) ถึง 25 (เวลา 07:00 น.) 
ธันวาคม 2560 (มม./24ชม.) จากระบบของ Mekong River Commission Flash Flood Guidance System 
(MRCFFGS) กับข้อมูลของ สสนก. โดยข้อมูลปริมาณฝนสะสม 24 ชั่วโมงแสดงให้เห็นว่าพ้ืนที่ภาคใต้ของ
ประเทศไทยมีปริมาณฝนสะสมอยู่ในเกณฑ์ฝนน้อยต่้ากว่า 20 มม./24ชม. โดยพบว่าปริมาณฝนส่วนใหญ่ตกใน
เขตพ้ืนที่จังหวัดตรัง นครศรีธรรมราช พัทลุง สงขลา ยะลา ปัตตานี และนราธิวาส 

นอกจากนั้นแล้วระบบ MRCFFGS มีการประมาณปริมาณฝนสูงกว่าความเป็นจริงในพ้ืนที่ภาค
ตะวันออกเฉียงเหนือตอนล่างและบางส่วนของพ้ืนที่ภาคตะวันออก เมื่อเทียบกับข้อมูลที่ได้จากการตรวจวัด
ของกรมอุตุนิยมวิทยา 

  



 

 

แผนที่ภูมิอากาศ (วันที่ 25 ธันวาคม 2560 เวลา 07:00) 

 

แผนที่เส้นทางพายุและคาดการณ์ (วันที่ 25 ธันวาคม 2560 เวลา 07:00) 

  



  

ปริมาณฝนสะสม 24 ชั่วโมง (MRCFFGS) ปริมาณฝนสะสม 24 ชั่วโมง (สสนก.) 

 

ปริมาณฝนสะสม 24 ชั่วโมง (กรมอุตุนิยมวิทยา) 

  



 

 
ปริมาณฝนสะสม 24 ชั่วโมง (MRCFFGS) 

 

3) ปริมาณความชื้นในดิน 

ปริมาณความชื้นในดินในพ้ืนที่ภาคใต้ของประเทศไทยจากระบบของ MRCFFG ของวันที่ 25 (เวลา 
07:00 น.) ธันวาคม 2560 อยู่ในเกณฑ์ประมาณ 60-80 % ซึ่งหมายถึงดินในพ้ืนที่ภาคใต้ยังสามารถรองรับ
ปริมาณน้้าฝนได้อีก โดยจะส่งผลปริมาณฝนที่จะตกในช่วงแรกๆนั้นสามารถไหลซึมลงสู่ชั้นดินก่อนที่จะ
เปลี่ยนแปลงเป็นปริมาณน้้าผิวดิน ซึ่งปริมาณความชื้นดังกล่าวมีแนวโน้มเพ่ิมขึ้นเมื่อเทียบกับวันที่ 22 ธันวาคม 
2560 ประมาณร้อยละ 20 เนื่องจากปริมาณฝนในพ้ืนที่ตลอดสุดสัปดาห์ที่ผ่านมา 

 

4) FFG (Flash Flood Guidance) 

FFG หมายถึง ค่าความสามารถในการรองรับปริมาณฝนของพ้ืนที่นั้นๆ ก่อนที่จะเกิดสภาวะน้้าล้นตลิ่งที่
จุดออกของปลายพ้ืนที่ โดยค่า FFG 06-hr หมายถึง ปริมาณฝนที่จะส่งผลให้เกิดสภาวะน้้าล้นตลิ่งที่ปลายลุ่ม
น้้าในอีก 6 ชั่วโมงข้างหน้า (มม./6ชม.) ซึ่งพ้ืนที่ภาคใต้ของประเทศไทย ณ เวลานี้สามารถรองรับปริมาณฝนได้
ประมาณ 120-180 มม./6ชม. ซึ่งค่าความสามารถดังกล่าวมีแนวโน้มลดลงเมื่อเทียบกับวันที่ 22 ธันวาคม 
2560 ประมาณ 20 มม./6ชม. เนื่องจากปริมาณฝนในพ้ืนที่ตลอดสุดสัปดาห์ที่ผ่านมา 

 



 
ปริมาณความชื้นในดิน (MRCFFGS) 

 

 
Flash Flood Guidance 06-hr  

(วันที่ 25 ธันวาคม 2560 เวลา 07:00 น.) 
 

  



5) ปริมาณฝนคาดการณ์ล่วงหน้า 24 ชั่วโมง 

ปริมาณฝนคาดการณ์ล่วงหน้า 24 ชั่วโมง (วันที่ 26 ธันวาคม 2560 เวลา 7:00 น.) โดยระบบ MRCFFG 
คาดการณ์ว่าในอีก 24 ชั่วโมงข้างหน้า ภาคใต้ของประเทศไทยจะมีปริมาณฝนสะสมสูงสุดประมาณ 10-30 
มม./24ชม. นอกจากนั้นแล้วระบบของ สสนก. คาดการณ์ว่าภาคใต้ของประเทศไทยจะมีปริมาณฝนสะสม
สูงสุดประมาณ 20-70 มม./24ชม. 

  
ปริมาณฝนคาดการณ์ 24 ชั่วโมง 

ล่วงหน้า (MRCFFGS) 
ปริมาณฝนคาดการณ์ 24 ชั่วโมง ล่วงหน้า (สสนก.) 



 

 
ปริมาณฝนคาดการณ์ล่วงหน้า 24 ชั่วโมง  
(วันที่ 26 ธันวาคม 2560 เวลา 7:00 น.) 

 

 



สถานการณ์ฝนและพื้นที่เสี่ยงอุทกภัยจากอิทธิพลของพายุโซนร้อน“เท็มบิน” 
(TEMBIN) 

วันที่ 26 ธันวาคม 2560 เวลา 07:00 น. 

 

พ้ืนที่ภาคใต้ของประเทศไทยสามารถรองรับปริมาณฝนได้ประมาณ 150-180 มม./6ชม. และพ้ืนที่
ดังกล่าวมีปริมาณความชื้นในดินที่ประมาณประมาณ 60-80% โดยค่าดังกล่าวแสดงถึงศักยภาพในการรองรับ
ปริมาณน้้าฝนที่จะตกลงในพื้นที ่

ปริมาณฝนคาดการณ์ล่วงหน้า 24 ชั่วโมง (วันที่ 27 ธันวาคม 2560 เวลา 7:00 น.) โดยระบบ MRCFFG 
คาดการณ์ว่าในอีก 24 ชั่วโมงข้างหน้า ภาคใต้ของประเทศไทยจะมีปริมาณฝนสะสมสูงสุดประมาณ 40 มม./
24ชม. และระบบของ สสนก. คาดการณ์ว่าจะมีปริมาณฝนสะสมสูงสุดประมาณ 70 มม./24ชม. ซึ่งมีค่าน้อย
กว่าความสามรถในการรับน้้าฝนของพ้ืนที่ประมาณ 80-110 มม./6ชม. ดังนั้นจึงสามารถสรุปได้ว่าในอีก 24 
ชั่วโมงข้างหน้าพื้นที่ภาคใต้ของประเทศไทยยังไม่เสี่ยงต่อพื้นที่น้้าท่วมฉับพลัน แต่อย่างไรก็ตามควรจะเฝ้า
ติดตามสถานการณ์เพื่อดูการเปลี่ยนแปลงทุกๆ 3-6 ชั่วโมง 

 

1) ลักษณะส้าคัญทางภูมิอากาศ 

วันที่ 26 ธันวาคม 2560 เวลา 04.00 น. พายุโซนร้อน“เท็มบิน” (TEMBIN) บริเวณทะเลจีนใต้
ตอนกลาง ก้าลังเคลื่อนตัวทางทิศตะวันตกด้วยความเร็วประมาณ 30 กิโลเมตรต่อชั่วโมง คาดว่าจะเคลื่อนตัว
ผ่านทางตอนใต้ของประเทศเวียดนามในวันนี้ (26 ธันวาคม 2560) และมีแนวโน้มจะอ่อนก้าลังลงเป็นพายุ
ดีเปรสชันและหย่อมความกดอากาศต่้าก้าลังแรง ตามล้าดับ ก่อนจะเคลื่อนตัวลงสู่อ่าวไทยและภาคใต้ของ
ประเทศไทย 

ส่งผลให้ระหว่างวันที่ 26-27 ธันวาคม 2560 ประเทศไทยตอนบนจะมีฝนเกิดขึ้นได้ และส้าหรับภาคใต้
จะมีฝนตกหนักบางพ้ืนที่ โดยเฉพาะจังหวัดประจวบคีรีขันธ์ ชุมพร และสุราษฎร์ธานี 

2) ปริมาณฝน 

ผลการเปรียบเทียบปริมาณฝนสะสม 24 ชั่วโมง ของวันที่ 25 (เวลา 07:00 น.) ถึง 26 (เวลา 07:00 น.) 
ธันวาคม 2560 (มม./24ชม.) จากระบบของ Mekong River Commission Flash Flood Guidance System 
(MRCFFGS) กับข้อมูลของ สสนก. โดยข้อมูลปริมาณฝนสะสม 24 ชั่วโมงแสดงให้เห็นว่าพ้ืนที่ภาคใต้ของ
ประเทศไทยมีปริมาณฝนสะสมอยู่ในเกณฑ์ฝนน้อยต่้ากว่า 20 มม./24ชม. โดยพบว่าปริมาณฝนส่วนใหญ่ตกใน
เขตพ้ืนที่จังหวัดนครศรีธรรมราช พัทลุง สงขลา ยะลา ปัตตานี และนราธิวาส 



นอกจากนั้นแล้วระบบ MRCFFGS มีการประมาณปริมาณฝนสูงกว่าความเป็นจริงในพ้ืนที่ภาคกลาง 
ภาคตะวันออกเฉียงเหนือตอนล่าง และบางส่วนของพ้ืนที่ภาคตะวันออก เมื่อเทียบกับข้อมูลที่ได้จากการ
ตรวจวัดของกรมอุตุนิยมวิทยา 

 

แผนที่ภูมิอากาศ (วันที่ 26 ธันวาคม 2560 เวลา 07:00) 

 

แผนที่เส้นทางพายุและคาดการณ์ (วันที่ 26 ธันวาคม 2560 เวลา 07:00) 

  



  

ปริมาณฝนสะสม 24 ชั่วโมง (MRCFFGS) ปริมาณฝนสะสม 24 ชั่วโมง (สสนก.) 

 

ปริมาณฝนสะสม 24 ชั่วโมง (กรมอุตุนิยมวิทยา) 

  



 

 
ปริมาณฝนสะสม 24 ชั่วโมง (MRCFFGS) 

 

3) ปริมาณความชื้นในดิน 

ปริมาณความชื้นในดินในพ้ืนที่ภาคใต้ของประเทศไทยจากระบบของ MRCFFG ของวันที่ 26 (เวลา 
07:00 น.) ธันวาคม 2560 อยู่ในเกณฑ์ประมาณ 60-80 % ซึ่งหมายถึงดินในพ้ืนที่ภาคใต้ยังสามารถรองรับ
ปริมาณน้้าฝนได้อีกก่อนที่จะเข้าสู่สภาพอ่ิมตัว โดยจะส่งผลปริมาณฝนที่จะตกในช่วงแรกๆนั้นสามารถไหลซึม
ลงสู่ชั้นดินก่อนที่จะเปลี่ยนแปลงเป็นปริมาณน้้าผิวดิน 

4) FFG (Flash Flood Guidance) 

FFG หมายถึง ค่าความสามารถในการรองรับปริมาณฝนของพ้ืนที่นั้นๆ ก่อนที่จะเกิดสภาวะน้้าล้นตลิ่งที่
จุดออกของปลายพ้ืนที่ โดยค่า FFG 06-hr หมายถึง ปริมาณฝนที่จะส่งผลให้เกิดสภาวะน้้าล้นตลิ่งที่ปลายลุ่ม
น้้าในอีก 6 ชั่วโมงข้างหน้า (มม./6ชม.) ซึ่งพ้ืนที่ภาคใต้ของประเทศไทย ณ เวลานี้สามารถรองรับปริมาณฝนได้
ประมาณ 150-180 มม./6ชม. 

 



 
ปริมาณความชื้นในดิน (MRCFFGS) 

 

 
Flash Flood Guidance 06-hr  

(วันที่ 26 ธันวาคม 2560 เวลา 07:00 น.) 
 

  



5) ปริมาณฝนคาดการณ์ล่วงหน้า 24 ชั่วโมง 

ปริมาณฝนคาดการณ์ล่วงหน้า 24 ชั่วโมง (วันที่ 26 ธันวาคม 2560 เวลา 7:00 น.) โดยระบบ MRCFFG 
คาดการณ์ว่าในอีก 24 ชั่วโมงข้างหน้า ภาคใต้ของประเทศไทยจะมีปริมาณฝนสะสมสูงสุดประมาณ 30-40 
มม./24ชม. นอกจากนั้นแล้วระบบของ สสนก. คาดการณ์ว่าภาคใต้ของประเทศไทยจะมีปริมาณฝนสะสม
สูงสุดประมาณ 20-70 มม./24ชม. 

  
ปริมาณฝนคาดการณ์ 24 ชั่วโมง 

ล่วงหน้า (MRCFFGS) 
ปริมาณฝนคาดการณ์ 24 ชั่วโมง ล่วงหน้า (สสนก.) 



 

 
ปริมาณฝนคาดการณ์ล่วงหน้า 24 ชั่วโมง  
(วันที่ 27 ธันวาคม 2560 เวลา 7:00 น.) 

 

 


